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Chapter 1: Before you begin

This chapter describes the basic features of Matrox Capture 
Works, minimum requirements, and resources for more 
help.
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Matrox Capture Works overview

Matrox Capture Works is a GUI for 2D and 3D GenICam-compliant imaging 
devices that use standard interfaces like GigE Vision, USB Vision, CoaXPress, or 
GenTL. With this utility, you can rapidly evaluate the performance and 
functionality of virtually any GenICam-compliant camera or 3D sensor (or other 
device). You can also allocate your device, start or stop acquisitions, analyze and 
visualize captured data, save grabbed data, send a software trigger, as well as browse 
and control the selected device's features. Matrox Capture Works is distributed 
with MIL and Matrox Design Assistant; it is also available with MIL-Lite.

When using Microsoft Windows, Matrox Capture Works is launched from the 
MIL Control Center (found under Matrox Imaging in the Windows Start menu) 
or by typing "Capture Works" in the Windows Start menu. If using Linux, Matrox 
Capture Works is launched by typing "Capture Works" in the activities bar. 
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Matrox Capture Works features
Matrox Capture Works offers the following features:

• Matrox device discovery service. Matrox Capture Works can automatically detect 
when compatible devices (such as, Matrox AltiZ or a third-party compliant device) 
are connected to or removed from your computer/network.

• Support for multiple interfaces. Matrox Capture Works supports 2D and 3D 
imaging devices with the following interfaces, provided that their corresponding 
MIL drivers are installed: GigE Vision, USB3 Vision, GenTL, and CoaXPress.

• Built-in feature browser. Matrox Capture Works provides a built-in feature 
browser to control/inquire about a connected device that has GenICam support. 
It also allows you to control/inquire about the digitizer/frame grabber used to 
interface with the device.

• Dynamic window layout. The windows in Matrox Capture Works can be 
customized to fit your specific workflow.

Minimum requirements

The minimum requirements to run Matrox Capture Works are the same as those 
for MIL. 

For Microsoft Windows
To run under Microsoft Windows, you will need a minimum hard disk space of 
6 Gbytes for the MIL development environment and a minimum of 250 Mbytes 
of free hard disk space to install the MIL runtime environment without any boards 
selected. Also, you will need a computer with a CPU that supports the SSE4.2 
instruction set.

For Linux
To run under Linux, you will need a minimum hard disk space of 5 Gbytes for 
the MIL development environment and a minimum of 772 Mbytes of free hard 
disk space to install the MIL runtime environment without any boards selected. 
Also, you will need a computer with a CPU that supports the SSE4.2 instruction 
set.
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Matrox Capture Works installation

To install Matrox Capture Works, you need to install MIL or Matrox Design 
Assistant with a driver for a GigE Vision, USB3 Vision, or GenTL,  
Matrox Rapixo CXP. If you already have MIL installed with any of the listed drivers 
and you don’t see Matrox Capture Works, you can update those drivers and Matrox 
Capture Works will be installed.

Documentation conventions and notes

When the term Host is used in this manual, it refers to the host computer.

The term component refers to a component of a container. The color bands of an 
image are stored in the same component (typically, the intensity component).

Useful to know Note it is useful to use the bookmarks at the left (PDF TOC) and CTRL+Shift+F 
to navigate this PDF. The latter displays all instances of the searched term(s) in 
the PDF with a bit of context. 

Need help?

If you experience problems during installation or while using this product, you 
can refer to the support page on the Matrox Imaging web site: 
https://www.matrox.com/en/imaging/support/tech-support. The support page 
provides information on how to contact technical support.

To request support, you should first complete and submit the online Technical 
Support Request Form, accessible from the above-mentioned web page. Once you 
have submitted the information, a Matrox support agent will contact you shortly 
thereafter by email or phone, depending on the problem.

Matrox Vision Academy
Matrox provides the Matrox Vision Academy online training resource to help 
customers visualize the steps involved in using various products. If using Matrox 
AltiZ, specialized Matrox Vision Academy videos provide guidance on basic and 
advanced steps used in working with Matrox Capture Works. For access to these 
videos, visit https://www.matrox.com/en/imaging/apps/vision_academy/course.
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Chapter 2: Using Matrox 

Capture Works

This chapter describes the Matrox Capture Works interface 
and how it is used.
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Navigating Matrox Capture Works

To launch Matrox Capture Works, open the MIL Control Center (found under 
Matrox Imaging in the Windows Start menu) and select Matrox Capture Works. 
Once open, the windows of Matrox Capture Works can be pinned, removed, and 
re-sized. To reset the default window layout, select Window, and then select Reset 
Window Layout; alternatively, press CTRL+Z. 

Matrox Capture Works windows
The image below shows the default layout of the Matrox Capture Works windows, 
as well as the standard areas of the Matrox Capture Works interface.  

Histogram,
Memory Viewer, and
Measurements/ Volume Properties windows

Events,
Feature Description, and
Feature Code Snippet windows

Progress bar area

3D and Profile
View Controls
window

Devices
window

Menu bar and toolbar

Acquisition windowFeature rowserB
window

Matrox Capture Works
main window
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The Matrox Capture Works interface is divided as follows. Note that some 
windows are initially hidden, but can be displayed using the View menu.   

Interface element Description

Menu bar and toolbar Provide typical options and device control functionality. See below for a description of the toolbar 
buttons.

Devices window Displays all compatible devices connected to your computer/network. From this window, you are 
able to find and allocate a device (using the right-click context menu).

Matrox Capture Works main window

(Feature Browser and Acquisition 
windows)

Displays information related to the allocated device and 2D and/or 3D views of the acquired data. 
Note that the name of this window will change depending on the selected device. There are two 
windows inside the Matrox Capture Works main window: Feature Browser window and 
Acquisition window. The Acquisition window presents three additional windows that are enabled 
when a 3D device is allocated: 2D View window, 3D View window, and Profile View window.

Matrox AltiZ Setup window Allows you to validate and interactively optimize features related to laser intensity, exposure, peak 
extraction, and fusion. It is also available to set up your scan area and offset. This window is 
accessible by clicking on the Matrox AltiZ Setup toolbar button when a Matrox AltiZ is connected.

Events window Displays events such as errors, warnings, and information messages logged by Matrox Capture 
Works.

Feature Description window Displays information related to the selected feature.

Feature Code Snippet window Displays a code snippet of the selected features, which shows how to control/inquire these feature 
in MIL.

Histogram window Displays a histogram that reports the frequency of the values found in the selected component of 
the currently displayed data. To select a component, use the dropdown list at the top of this 
window. Only the components that are enabled for transmission from the device are listed.

Measurement/ Volume Properties window Displays the distance between two selected points. This window is visible when the Profile View 
window is selected, and either points have been selected in the profile or markers have been set in 
the horizontal or vertical ruler.

Memory Viewer window Displays the numerical values at specific rows and columns of the selected component.

3D and Profile View Controls window Provides quick access to settings that modify the display of the acquired 3D data. These settings 
allow you to modify the view mode, window layout, 2D View window, the Profile View window, 
and the 3D View window. This window is only available when acquiring 3D data.

Progress bar area Shows the progress of the acquisition. 
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Main toolbar buttons
The top of the Matrox Capture Works interface includes toolbar buttons that are 
used to interact with your connected device. The toolbar buttons have the 
following functionality:    

Toolbar button name Description

Allocate device/Free device (1) Allows you to allocate or free the device currently selected in the Device window. This button is 
disabled until you select a device. Once a device is selected, you can click on the arrow to allocate 
the device using a predefined configuration file (DCF file), a custom DCF, or a SDCF (Simulated 
DCF). To select a custom DCF, chose Browse... and navigate to the location where the custom DCF 
is found. After a device is allocated, a red dot will appear on the button.

Perform Device Discovery (2) Allows you to initiate a device discovery.

Load (3) Allows you to load 2D or 3D data in any supported format into Matrox Capture Works. Supported 
formats include .bmp, .gendc, .jpg, .mim, .ply, .png, .raw, .stl, .tif, and proprietary MIL files (.muf or 
.mbufc).

Save (4) Allows you to save your 2D or 3D data to a file in any of the supported file formats. Note that, 
depending on how your data is represented, you might not be able to save to some file types. Also, 
be aware that this save button is not the same as the one found in the Feature Browser (D in the 
Feature Browser toolbar buttons table of the Feature Browser window section later in this chapter).

Single Grab (5) Allows you to grab a frame of data from your device. 

Continuous Grab (6) Allows you to play or pause a live feed from your device.

Copy into New Buffer (7) Allows you to copy the acquired data to a new tab. This allows you to compare new acquisitions 
with the copied data, or save it for later inspection.

File access (8) Allows you to upload or download a previously saved device-specific file (such as a user set file). 

Matrox AltiZ Setup (9) Allows you to validate and interactively optimize features related to laser intensity, exposure, peak 
extraction, and fusion. It is also available to set up your scan area and offset. 

This toolbar button only appears when a Matrox AltiZ is allocated.

Grab Settings (10) Allows you to specify the number of frames that can be buffered, and the grab timeout, in msec.

Display settings (11) Allows you to make changes to the display settings of the displayed images or 2D data. This button 
is accessible after an acquisition has been made or an image has been loaded. It should be noted 
that the maximum display refresh rate is 60 Hz, even if the grab is much faster.
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2D toolbar buttons
When 2D data is displayed, the 2D toolbar buttons become available next to the 
main toolbar buttons. The 2D toolbar buttons have the following functionality:  

Toolbar button name Description

View Finder Grid (1) Adds a grid to the Acquisition window to help with camera position adjustments. The rows, 
columns, and intensity of the lines can be adjusted using a sliding bar or by manually entering 
values. 

View Finder Crosshair (2) Adds a crosshair to the middle of the Acquisition window to help identify the center of the 
acquisition. The size and intensity of the crosshair lines can be adjusted by a sliding bar.

Draw Line Profile (3) Adds a line between two selected locations in the Acquisition window. You can click on different 
parts of the line to get the RGB or Mono values of a pixel at that particular location. The number of 
pixels along the line determines the length of the X-axis of the Line Profile graph. Clicking on a point 
in the Line Profile graph will make a point appear on the line, which represents the location of the 
selected pixel. 

Draw Arc Profile (4) Adds an arc between two selected locations in the Acquisition window. You can click on different 
parts of the arc to get the RGB or Mono values of a pixel at that particular location. The number of 
pixels along the arc determines the length of the X-axis of the Line Profile graph. Clicking on a point 
in the Line Profile graph will make a point appear on the arc, which represents the location of the 
selected pixel.

1 2 3 4
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Allocating and naming devices with Matrox 
Capture Works

To set device features with Matrox Capture Works, perform the following:

1. Launch Matrox Capture Works from the MIL Control Center (found under 
Matrox Imaging in the Windows Start menu) or by typing "Capture Works" in 
the Windows Start menu.

2. Select the required standard interface from the tree structure (for example, select 
GigE Vision). This tree will show all the cameras and 3D sensors connected to 
your computer/network that use the selected standard. Double-click on your 
connected device to allocate it. You can also allocate a device by right-clicking on 
your connected device and selecting Allocate, or by selecting it and pressing the 
Allocate device toolbar button. You can allocate more than one device and they 
will appear as tabs at the bottom of the Matrox Capture Works main window. If 
a target device is not connected, you can use a simulated device, see the Allocating 
simulated devices subsection later in this section.  

Note that you can hover your mouse over the required device in the devices list 
to see information about the device (for example, its IP address). 
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3. Click on the Feature Browser tab. The list of available configurable and/or 
inquirable features is displayed in a tree structure. To expand the tree structure, 
double-click on any item. The description of each feature is given in the Feature 
Description window, and a code snippet is generated in the Feature Code Snippet 
window; the code snippet can be copied directly into MIL C++ code, or if not 
using C++, copied and appropriately adjusted.

4. Optionally, if you have not already done so, name your selected device. Open the 
Device Control item in the Feature Browser structure tree. Enter the name for 
your device in the Device User ID feature and press enter to apply changes.

5. If required, modify the setting of a feature listed in the Feature Browser tab, using 
the presented edit field or dropdown list.

6. To save the changes made with Matrox Capture Works to a user set, use the User 
Set Selector and the User Set Save features. These features allow you to select a 
user set and then save the device’s current configuration to this user set, 
respectively. To reload it, select it using the User Set Selector feature and then use 
the User Set Load feature. If you want to load this user set every time you power 
up your device, set it as the default user set using User Set Default Selector.

Allocating simulated devices
If you don’t have any compatible, connected devices, you can test Matrox Capture 
Works functionality using a simulated device. A simulated device can grab 
automatically generated images/3D data at a specified frame rate, resolution, and 
pixel format. The resolutions and frame rates available for simulated devices are 
indicated in the names of their SDCFs: 2D_SIMULATOR, 3D_SIMULATOR, 
1024_100fps_Mono, Bayer_HD, FullHD, HD, and Mono. A simulated device 
can also grab images/3D data from a folder or from an AVI file. 

If you do not have any devices connected when you first start Matrox Capture 
Works, a default simulated device will appear in your device list. If your devices 
are already connected when you start Matrox Capture Works, the simulated device 
will be disabled by default and you will have to enable it manually. 
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To enable simulated devices, perform the following:

1. Select Options from the Tools menu. In the presented dialog, click on the 
Simulated Device tab

2. Select Enable simulated devices. 

3. Once a simulated device is enabled, expand the Host Device system, expand Host 
Interface, and select Matrox MIL Software Emulator. 

4. To select what type of simulated device you will allocate, use the dropdown arrow 
on the Allocate device toolbar button; you will see a list of the SDCF’s available 
for allocation. 

Note that simulated devices do not display the Feature Browser.
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Uploading/downloading user sets and other 
files to/from a device

To download files (for example, user sets) from your device to your computer or 
to upload files (for example, user sets) from your computer to a device, use the 
File Access toolbar button in the Matrox Capture Works main window. After 
clicking on the File Access toolbar button, a dialog box opens for you to select 
whether to upload or download files to or from the device. Once you select the 
required operation, a window opens that allows you to select the location or 
destination for the files on your computer.

Note that if a user set is loaded onto the device, it will also have to be selected
using UserSetSelector and initialized using UserSetLoad.
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Feature Browser window

The Feature Browser allows you to control/inquire about a connected device that 
has GenICam support. It also allows you to control/inquire about the 
digitizer/frame grabber used to interface with the device. You can add features 
accessed regularly to your favorites. If you need specific features of your device to 
have certain values, and you want to deploy multiple devices with the same feature 
settings, you can also use the Feature Browser to create a custom DCF. When you 
select or modify a feature, the Code Snippet window provides a corresponding 
snippet of MIL code that you can use to do the same at runtime.

Feature Browser toolbar 
The Feature Browser toolbar has its own toolbar, as described below.   

Interface element Description

Target device dropdown list (A) Allows you to select the device, MIL digitizer, or MIL system from which to list features in the 
Feature Browser.

Feature search field (B) Allows you to search for a specific feature by its name.

Expand all toolbar button (C) Allows you to expand all feature categories. If all the feature categories are already expanded, you 
can also press this button to collapse all feature categories.

Generate DCF toolbar button (D) Allows you to generated a DCF with the camera features or digitizer controls that you have manually 
selected to include in your DCF from the Feature Browser. To select a feature for inclusion, select 
Add to DCF from the feature’s context menu. When you click on the Generate DCF toolbar button, 
you will be able to choose the file name of the DCF and the location in which to save it. Note that 
this save button is not the same as the one found in the main toolbar (#4 in the main toolbar 
buttons table). For information on how to set features to be included in a DCF, see the Creating a 
custom DCF section later in this chapter.

Favorites toolbar button (E) Opens the Favorites page. Selecting it a second time will return you to the complete Feature 
Browser features list.

Remove all favorites toolbar button (F) Removes all features that were added to the Favorites page.
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Adding features to the Favorites page
Some devices have many features, which can make it hard to find features quickly. 
If you use certain features regularly, you can add them to your favorites to save 
time when searching for them. To add a feature to your favorites, right-click on 
the feature and select Add to favorites. This will add the feature and its selector 
node to the Favorites page. To access the Favorites page, click on the Favorites 
toolbar button (star) found in the Feature Browser window. 

Creating a custom DCF
A custom DCF is useful for simplifying set up. It is ideal in cases where you only 
need specific features of your device to have certain values, and you want to deploy 
multiple devices with the same feature settings. A custom DCF is similar to a user 
set, but it allows you to change specific feature values instead of changing all of 
them. Although initially the features will have the same settings, they can be 
changed. A custom DCF can include both camera features and digitizer controls, 
but only writable features and controls can be added. 

Note that adding a persistent feature (for example, Persistent IP or Device User 
ID) to a DCF might cause conflicts when connecting multiple devices, since the 
persistent feature value will be the same for all devices.

To create a custom DCF, perform the following:

1. Allocate your device. 

2. If you need to include features that are specific to the digitizer of your device, 
select Digitizer from the Target device dropdown list.      

3. Once you have selected the required target device, right-click on the camera feature 
or digitizer control to be added and select Add to DCF from the context menu. 
The value that is set for each feature or control will be the value that is saved in 
the custom DCF. If you require a different value, you will need to change the value 
and re-save the DCF.
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You can identify which features or controls have been selected for the custom DCF 
by the save icon that appears next to them:  

4. After all of the required features are selected for your custom DCF, select the 
Generate DCF button to save the DCF. You will be able to change the name of 
the file and select where to save the DCF file.

To load a custom DCF, perform the following:

1. Select the dropdown arrow of the Allocate device toolbar button.

2. Select Browse... and navigate to the location with your custom DCF.

3. After selecting the custom DCF, your device will be allocated with the new DCF.

Note that, if you try to load a DCF on a device that does not support the features 
or controls found in the DCF, then the allocation will fail.

You can modify the features included in an existing DCF. To change which features 
are included, load the required DCF, add or remove features as described above, 
and save the DCF.

Code snippets
The Feature Code Snippet window is available by selecting Feature Code Snippet 
from the View menu. This window provides snippets of code for the currently 
selected features in the Feature Browser. These snippets can be copied directly into 
your MIL C++ code, or if not using C++, copied and appropriately adjusted.  
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Acquisition window

The Acquisition window is where data captured by your allocated device is 
displayed. Both 2D and 3D data are displayed in this window. In the Acquisition 
window, you can add a grid and cross hair, select between multiple components, 
and copy the acquired data to another tab. Depending on which type of data is 
displayed, some of the options will not be available (for example, View Finder 
Grid and View Finder Crosshair are only available when displaying 2D data). 
When displaying data acquired with a 3D device, additional options are available; 
see the 3D and Profile View Controls section for information these options.

View Finder Grid and View Finder Crosshair tools
The View Finder Grid and View Finder Crosshair tools are available when 
allocating a 2D device, or when using the 2D View mode for an allocated 3D 
device. These tools are specific to the selected component.

Adding a grid to the Acquisition window will help you section off the acquired 
data into quadrants, which is useful for camera position adjustments. You can 
manually select the number of rows and columns your grid has by clicking the on 
the dropdown arrow on the View Finder Grid toolbar button. Adding a crosshair 
to the Acquisition window will help identify the center of the acquired data. The 
size and intensity of the crosshair can be modified by clicking on the dropdown 
arrow on the View Finder Crosshair toolbar button and changing the settings. 

Selecting between multiple components
When you allocate a multi-stream device or a 3D device, your acquired data is 
composed of multiple components. Non-image/non-range components are not 
displayed by default. However, to display these components, select Options 
from the Tools menu; then, select View and enable Display All Components.

You can switch between components using tabs at the bottom of the Acquisition 
window. Only components that are enabled during acquisition are available. If 
you don’t see a component that you would like to display, you will need to enable 
it before acquisition.

Copying the grabbed image/3D data
You can copy the grabbed image or 3D data to another tab using the Copy into 
New Buffer toolbar button. This allows you to compare new acquisitions with 
the copied data, or save it for later inspection.



22   Chapter 2: Using Matrox Capture Works

3D and Profile View Controls

The 3D and Profile View Controls window provides a number of options for 
displaying the data acquired with a 3D device. To access this window, select 3D 
and Profile View Controls from the View Mode menu. The options found in the 
3D and Profile View Controls window are grouped under View Mode and 
include the following modes: 2D View, 3D View, and 3D View With Profile. 
Lock Views is another option available in the 3D and Profile View Controls 
window, but is discussed in the Comparing and locking multiple windows section 
later in this chapter. Note that, no settings will be available in this window when 
grabbing 2D data. 

2D View mode
When 2D View mode is selected, all the acquired 2D components are displayed 
in a 2D View window. The same options are available as when displaying images 
from a 2D device. See the Acquisition window section for information on these 
options.
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3D View mode
When the 3D View mode is selected, acquired 3D data is displayed in a 3D View 
window; options include: position and orientation of the view, thickness of the 
points (Point Size), and the color mapping of the points. 

To change the position and orientation of the view of the acquired object, you can 
left-click, right-click, or center click and drag your mouse to drag-rotate, drag-pan, 
or zoom the view, respectively. Alternatively, you can set: Azimuth, Elevation, 
Roll, and Distance.  

You can also use the number keys on the number row.  

Number key Description

Reference mode and Distance 
mode

Height mode

1 Top-tilted view Bottom-tilted view

2 Top view Bottom view

3 Front view Rear view

4 Left side view Left side view

5 Rear view Front view

6 Right side view Right side view

7 Bottom-tilted view Top-tilted view

8 Bottom view Top view
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Depending on the selected Anchor coordinate system mode, you might also need 
to flip the Z-axis in the view, so that the acquired data appears right side up. You 
can flip any of the three axes in the view by selecting the corresponding checkbox 
next to the one to flip. Note that, flipping only changes the position and 
orientation of the view; it does not change the data nor the direction of the axes 
relative to each other (right-handedness).

For better visibility, you can also select a specific color mapping and chose to invert 
the mapping. All color mapping is relative to the Z-axis. The possible options 
available for colormaps are listed in the table below:  

Colormap option Definition

Heat This colormap transitions from black, to red, to yellow, and then, to white along the 
RGB cube as the indices increase. 

Hue This colormap transitions from red, to yellow, to green, to cyan, to blue, to 
magenta, and then, to red along the edge of the hue circle as the indices increase. 

Jet This colormap transitions from dark blue, to blue, to cyan, to yellow, to red, and 
then, to dark red along the RGB cube as the indices increase. 

Spectrum This colormap transitions from red, to yellow to green, to blue, and then, to violet 
along the RGB cube as the indices increase. This is a representation of the visual 
spectrum according to wavelengths. 

Turbo This colormap transitions from dark blue, to blue, to green, to yellow, to orange, to 
red, and then, to dark red along the RGB cube as the indices increase. 
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3D View With Profile mode
When 3D View With Profile mode is selected, two windows are displayed: the 
3D View window (which is described in the 3D View mode section above), and 
the Profile View window. In 3D View With Profile View mode, options include: 
how to display individual profiles and measuring points along a profile.

Selecting a profile in the Profile View window
You can select which profile of the acquired data to display in the Profile View 
window by enabling Show profile plane in 3D view and setting Profile Number 
to the profile of the acquired data to display in the Profile View window. Profile 
numbers range from 0 (first profile taken) to NumberOfProfiles -1. You can select 
to show or hide a profile plane in the 3D View window as a visual indication of 
which profile is displayed. There is also the option to flip the Z-axis of the profile 
in the Profile View window, if the object appears upside down.

Measuring points in the Profile View window
You can measure the distance between two selected points, in real world units, in 
the Profile View window. With an acquired profile in the Profile View window, 
click along a measurement axis to create a marker that displays the distance along 
the selected axis. This can be done in either the X-axis or Z-axis. Once the marker 
is placed, you can drag it along its axis, add additional markers to the measurement 
axis, or delete all markers by pressing the Delete key. 

Note that when taking measurements, you can only measure along the axes of the 
profile plane.
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The values for these distances are displayed in the Measurements window, as 
shown below. 
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For a multi-profile surface scan, first select a specific profile, as outlined in the 
Selecting a profile in the Profile View window subsection above. Now, you can click 
and drag the measurement marker along its axis to measure points on the selected 
profile, as displayed below.  
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Another way to take measurements, which is more accurate, is by selecting the 
individual points. If you zoom in on your profile, you will notice that the 
intensities of the profile have selectable points. To measure the distance between 
two points, click to select one point, and then hold Ctrl and click to select a second 
point. The distance between the two points will be displayed; the location of these 
points will also be shown in the 3D View window. 

Windows layout
If you have selected 3D View with Profile or All Views, then the Windows Layout 
buttons become available in the 3D and Profile View Controls window, as long 
as there is more than one component grabbed. These are used to quickly organize 
the windows that display your acquired data. The options for organizing your 
windows are: tabbed, vertical, horizontal, and tiled. You can also find these options 
by navigating to the Windows menu and selecting Manage View Layouts.
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Comparing and locking multiple windows

If you have allocated more than one device, you can display and compare the 
acquired 2D or 3D data across multiple windows. To do this, you will need to 
allocate the first device; then, undock the device’s main window by clicking and 
holding on the outer edge of the window, and then dragging it to where you like. 
Allocate the next device, and undock the device’s main window in the same way. 
Do this for all the devices whose windows you need to compare. If you free any 
of the devices, you will lose the acquired data. You can resize the undocked 
windows by clicking and dragging the edges to the required location. 

You can also use this undocking technique to compare the different components 
of acquired data with the components of data loaded from a specified file.

Note, if required, you can also undock component tabs. This is useful if you need 
to visually compare the information in different components.

Once you have multiple windows undocked and sized appropriately, you can also 
lock all views together when using a 3D device. This will apply any movement in 
one window to all of the windows that are open. This is useful when comparing 
multiple acquisitions and you need to move the object around in the acquisition 
window. To lock the views, select Lock Views in the 3D and Profile View Controls 
window. To reset the windows to their default locations, you can either use Ctrl+Z, 
or select Reset Window Layout from the Window menu item.

Note that Lock Views is only available for a device that grabs multiple 
components. Also, Lock Views is not able to lock views across different devices. 

For information on how to navigate the 3D and Profile View Controls window, 
see the 3D and Profile View Controls section earlier in this chapter.
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Inspecting your data

After acquisition, Matrox Capture Works allows you to inspect the data by taking 
a line or arc profile, taking the histogram, or viewing the data in the memory 
viewer.

Line profile and arc profile 
The Draw Line Profile and Draw Arc Profile tools are available when working 
with 2D data. These allow you to establish the value of each pixel along a line or 
arc, respectively. The X-axis represents the distance along the line/arc, in pixels, 
and the Y-axis represents the pixel intensity. The location of these toolbar buttons 
is described in the 2D toolbar buttons section earlier in this chapter.

To use the Draw Line Profile tool, select the Draw Line Profile toolbar button, 
and then click your mouse and drag a line across your area of interest in the 
2D View window. Similarly, to use the Draw Arc Profile tool, select the Draw 
Arc Profile toolbar button, click your mouse and drag it to define the diameter 
of the circle around your area of interest, and then click again to set it. Once the 
diameter for the Draw Arc Profile tool is set, drag your mouse to enlarge, shrink, 
or join the arc into a circle. After the Draw Line Profile or Draw Arc Profile tools 
are placed in the 2D View window, a graph appears in the Line Profile window, 
where you can hover your mouse over the graph to find the RGB or Mono pixel 
values at specific parts of the line or arc. When you hover your mouse over the 
graph, a small circle appears on the drawn line or arc to identify exactly where 
along the line or arc the pixel values are being taken. 
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In the image below, the Draw Line Profile tool is selected. A location is selected 
on the graph in the Line Profile window, as shown by the dots on the Red, Blue, 
and Green lines, and its corresponding position on the Draw Line Profile tool is 
visible.

Histogram
The Histogram window is available by selecting Histogram from the View menu. 
This window displays a histogram that reports the frequency of the values found 
in the selected component. The component selected in the Histogram window is 
not necessarily displayed in the Acquisition window.  
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Memory Viewer
The Memory Viewer window is available by selecting Memory Viewer from the 
View menu. This displays numerical values at specific rows and columns of a 
component. In the memory viewer, values of the component are displayed in 
hexadecimal by default; from the right-click context menu, you can select to 
display the values in decimal. The memory viewer can display the data of any 
image/component and is useful if you need to see the data of components that 
cannot be displayed. 

In the image below, the acquired pixel values are displayed in hexadecimal. 
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Firmware updates

Matrox Capture Works allows you to update the firmware of your connected 
device, as long as it supports the GenICam firmware update protocol. To update 
your firmware, first ensure that you have freed the device whose firmware you will 
be updating. Then, select Firmware Update from the Tools menu; the Firmware 
Update window is presented. From this window, select Firmware File and navigate 
to the fimware file (.guf ) to use to update your device. Once the file is chosen, 
specify which device to update by selecting the checkbox next to the device’s name. 
If a device is not compatible with the selected firmware file, then the device will 
appear grayed out. You can update multiple devices at the same time with the same 
firmware file by selecting their corresponding checkboxes.

Note that a firmware update is only available if it is supported by the connected 
device. 

Warning If you are doing a firmware update, be aware that there is the possibility of losing 
your user sets. It is advised for you to write down the feature values of any user set 
you need to backup, since they might be reset to their default values after the 
firmware update.
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Matrox AltiZ Setup window

The Matrox AltiZ Setup window is only available when Matrox AltiZ is connected 
to Matrox Capture Works. For detailed information on how to adjust the Matrox 
AltiZ settings used in this section (for example, adjusting the available range, 
setting laser brightness and exposure, and adjusting peak extraction and fusion 
settings), see the Matrox AltiZ Installation and Technical Reference manual. 

The Matrox AltiZ Setup window is accessible by clicking on the Matrox AltiZ 
Setup toolbar button (outlined in red below).   

This window is available in Matrox Capture Works to validate and interactively 
optimize features related to laser intensity, exposure, peak extraction, and fusion. 
It is also available to set up your scan area and offset. When you click on the Matrox 
AltiZ Setup toolbar button, a continuous single-profile scan begins and the 
window opens. The window presents a collection of pertinent features, the 
intensity components from both image sensors (the images of the laser line), as 
well as the acquired profile data (from the 3D reconstruction pipeline).
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Since the Matrox AltiZ Setup toolbar button automatically puts your device in 
continuous capture mode, you will need to manually stop the capture before you 
can make a change to some features (for example, the Anchor coordinate system 
mode). To do so, click on the Stop toolbar button. 

Once all your settings provide appropriate results, click on the check mark in the 

toolbar ( ), and the corresponding Matrox AltiZ features will 
be updated with these values. This will only change the values for the features that 
you have modified through the Matrox AltiZ Setup window; all of your other 
settings will remain the same.



36   Chapter 2: Using Matrox Capture Works

Laser brightness, exposure, and the extraction, fusion, 
filtering, and selection of peaks
The default values provided for laser brightness, exposure, extraction, fusion, 
filtering, and selection of peaks are appropriate for most cases, but if you need to 
modify these values, follow the steps below:

1. If no peaks are detected, the object could be outside the available range (either too 
far from Matrox AltiZ or too close to Matrox AltiZ). Adjust Matrox AltiZ so that 
the object is found within the available range. 

2. Adjust your laser brightness and exposure to ensure that you can see the laser line. 
The adjustments that you make to these settings are dynamic; you can see their 
effect in the two intensity component windows, making it easier for you to know 
when the settings are appropriate for your setup.

3. Set peak extraction features so that only peaks of interest are captured. For most 
use cases, the default peak extraction values are appropriate. If you need to change 
these values, you can use the Matrox AltiZ Setup window to validate and optimize 
laser intensity, exposure, peak extraction, and fusion features. You can also acquire 
data and view the histogram of the scatter component to help with further 
optimization. The scatter component’s histogram reports how many 
points/depths in the acquired data have a given scatter. The scatter of a point 
corresponds to the approximate width of the laser line, measured in pixel units, 
in the column from which its corresponding peak was extracted. Use the X-axis 
value of the highest peak to set the Peak Width Nominal feature to a more 
appropriate value.

4. Set peak fusion settings, so that only the most appropriate peaks are fused into a 
single peak. Also, set fused peak filter and selection settings so that the peaks in 
each column of the two images are properly processed to establish which peak is 
the correct peak for a particular column and what its corresponding depth and 
position are. The fused peaks are shown in the Profile View window. Different 
colors in this window represent whether a peak is fused and from which image 
sensor it originates, or whether the peak was not selected. Fused peaks are green, 
selected non-fused peaks from Source0 are blue, selected non-fused peaks from 
Source1 are yellow, and unselected peaks are red. As you make your changes to 
these features, the colors will also change, further allowing you to make a better 
decision on which settings to use.
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Scan area
You can also reduce and offset the scan area along the Z-axis, using the Matrox 
AltiZ Setup window, to include only the area of interest (for example, the top part 
of your object) instead of the entire available Z-range; this reduces the grabbed 
laser line image size and increases the acquisition speed. Have the highest point, 
and ideally the lowest point, of the object under Matrox AltiZ when you do the 
setup, so that you do not miss part of your object when scanning. 

To reduce and offset the scan area along the Z-axis, navigate to the Profile View 
window and drag the first measurement marker above the profile, so that it is 
slightly above. Now, drag the second measurement marker below the profile, so 
that it appears slightly below. In the Matrox AltiZ Volume Properties window, 
you will see the numbers that will be used for both Size Z World 
(Scan3dVolumeSizeZWorld) and Offset Z World 
(Scan3dVolumeOffsetZWorld).



38   Chapter 2: Using Matrox Capture Works



Chapter

3
3

Chapter 3: Step-by-step 
example use case 
with Matrox Capture 
Works

This chapter provides an overview of how to configure 
Matrox Capture Works for a common use case.
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Example use case with Matrox Capture 
Works

This chapter provides steps for an example use case. The example use case is taken 
with a JAI SP-25000C-CXP4A area scan camera connected to a Matrox Rapixo 
CXP board. The JAI camera can be configured using Matrox Capture Works. You 
can use any other compatible device to perform these actions, although the settings 
and values might be different. When you install your Matrox software (MIL, 
MIL-Lite, or Matrox Design Assistant), Matrox Capture Works is automatically 
installed. You can then launch the utility from the MIL Control Center (found 
under Matrox Imaging in the Windows Start menu) or by typing "Capture 
Works" in the Windows Start menu.

Matrox Vision Academy also provides videos for some of the Matrox AltiZ 3D 
use cases (not covered in this manual). To follow along with the videos, visit 
https://www.matrox.com/en/imaging/apps/vision_academy/course and go to the 
Using the Matrox AltiZ series under the Hardware section. For detailed 3D use 
cases, you can also see the Matrox AltiZ Installation and Technical Reference 
manual. 
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Use case: Performing a basic acquisition and 
taking a line profile

To quickly set up the JAI SP-25000C-CXP4A to perform a single 2D acquisition 
using default settings, do the following.

Note, in this example, we used a Matrox Rapixo CXP board as the scanned item.

1. Open Matrox Capture Works and allocate the SP-25000C-CXP4A by 
double-clicking on it in the presented list of available devices or by right-clicking 
on it and selecting Alloc.

2. Once your camera is allocated, click on the Single Grab toolbar button  
(  ) to initiate an acquisition. Depending on your light settings, you might 

need to make adjustments to enhance the quality of the image.  
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3. After a 2D image is acquired, you can now measure the pixel values in the image. 
Click on the Draw Line Profile toolbar button, and then click and drag the line 
over a location in the image along which to view the pixel values. Since our camera 
is a color camera, we will be able to see the RGB values of the pixels that are found 
along this line. Notice that when you hover over the graph in the Line Profile 
window, a circle appears on the line profile to indicate from where the pixel values 
are being taken. In this case, we are hovering over the pixel values from the gold 
finger of the board, as indicated by the red arrow seen in the image below.  
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4. If you find that your acquisition is running at such a high frame rate that some of 
the frames are missed, you can also disable the image display. To do so, click the 
Display Settings toolbar button and deselect Display grab image, as shown below. 
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